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INTRODUCTION 

Histopathology is the science that studies the signs of disease by studying the structural and functional changes that occur 

in cells and tissues. Visualization of differences in tissue components under a microscope is carried out by processing tissue 

biopsies or specimens and mounting them on glass slides, then the tissue is stained in such a way as to provide color contrast 

between the cells. Several types of dyes such as hematoxylin-eosin, immunohistochemistry, or immunofluorescence 

labeling have been widely used1. 

Hematoxylin and eosin (H&E) staining is the most commonly used light microscope staining method in histopathology 

laboratories and has been used by pathologists for over one hundred years. The H&E staining allows increasing contrast 

and distinguishing between nuclei and cytoplasm in tissues. Hematoxylin colors the cell nucleus blue, formed from 

aluminum ions and oxidized hematoxylin, while eosin colors the cytoplasm and connective tissue pink. Due to H&E's long 

history, established methods, and a large amount of data and publications, there is a strong belief among many pathologists 

that the practice of H&E will continue for the next 50 years2. Traditionally, histopathological testing is carried out by a 
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 Abstract 

Histopathology is the science that studies the signs of disease 
by studying the structural and functional changes that occur in 
cells using certain types of dyes such as hematoxylin and eosin 
(H&E). Traditionally histopathological testing is carried out 
using semi-quantitative methods. A more advanced method is 
done by taking photos digitally, and then digital photos are 
quantified with the help of software such as ImageJ using plug-
in tools. Recent advances in digital pathology require the 
development of more efficient computerized image analysis 
such as the Gaussian adaptive threshold method. This research 
aims to compare the calculation results of computer-assisted 
digitalization of histopathology using the ImageJ plugin 
manual method with automatic calculations using Gaussian 
adaptive threshold to quantify the amount of sciatic nerve cell 
damage in the Diabetic peripheral neuropathy (DPN) rat model. 
In this study, two image analysis methods were used to test 
their ability to measure the amount of cell damage in the sciatic 
nerve of normal rats using a model of diabetic neuropathy. The 
first method uses the ImageJ plugin manual. The second 
method is the Gaussian adaptive threshold method. The ImageJ 
plugin manual method obtained a cell abnormality value of 213 
cells. Meanwhile, with the Gaussian adaptive threshold 
method, a value of 204 cells was obtained. The calculation 
results of the two methods show an insignificant difference 
between the methods p >0.05. This study presents a 
computerized morphometric image analysis method with the 
potential for pathology digitalization applications. 
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pathologist using the eye to directly observe whether there are damages, differences, or cancer cells in a tissue sample after 

staining under a microscope using the semi-cutification method. This method takes time and effort. In addition, traditional 

detection methods are subjective and lack quantitative feature parameters as a reference, resulting in different recognition 

accuracies3. 

A more advanced method involves taking photos digitally with the help of software such as ImageJ and calculating 

manually using plug-in tools. Cell Counter Plug-in from the ImageJ platform (https://imagej.net/ij/index.html) was used 

to precisely count cell nuclei. ImageJ is a Java-based public domain image analysis program. ImageJ has become the image 

processing tool in many laboratories. However, counting nuclei one by one is laborious and time-consuming. Therefore, it 

becomes less effective in laboratories with a large number of cases for diagnosis, so automatic calculations of cellular nuclei 

using software began to be developed4. Therefore, efficient quantitative, stable, and accurate analysis detection, as well as 

cell image identification are the focus of many research works3. 

As technology develops, computer-aided disease diagnosis (CAD) plays a very important role and has become a major 

research subject in histopathological imaging and diagnostics. Computer-assisted histopathological studies have been 

performed for various breast cancer detection and assessment applications4-6, colon7,8, lung9, prostate10, skin11,12, and other 

cancers. However, histopathological detection of other diseases is still very limited. One of the diseases that may be observed 

with computer-assisted histopathological studies is damage to the sciatic nerve tissue in diabetic neuropathy. Diabetic 

neuropathy is a rapidly growing pathology and should be of global concern. In most cases, diabetic neuropathy begins as a 

small fiber neuropathy affected by lower serum glucose levels and blood flow13. Several human and animal studies have 

shown that hyperglycemia-related damage to unmyelinated C fibers, small myelinated Aδ fibers, and large myelinated Aβ 

fibers contribute to the development of diabetic peripheral neuropathy (DPN)14. 

Over the past few years, studies in animal models have begun to yield important insights into the mechanisms of pain in 

DPN. The streptozotocin (STZ)-induced rat model is the most widely used experimental model in diabetes models similar 

to humans. Induction of inflammation has been associated with microvascular tissue and nerve damage in human diabetes 

and rodent models of diabetes. The observed morphological damage could provoke functional deficits of the sciatic nerve 

in untreated diabetic rats. The presence of abnormal fibers in the sciatic nerve with axonal degeneration and myelin damage 

is one of the symptoms of streptozotocin-induced diabetes in rats15. The large number of abnormal cells in the sciatic nerve 

can indicate the severity of diabetic neuropathy. Therefore, it is hoped that quantification of abnormal cells can be the basis 

for diagnosing the severity of diabetic neuropathy in the future. Recent advances in digital pathology have required the 

development of quantitative computerized image analysis and automated algorithms to assist pathologists interpreting 

large numbers of histopathological digital images16. 

In this study, a comparative method of computer-assisted histopathological digital image analysis was carried out on the 

sciatic nerve from an animal model of diabetic neuropathy using manual calculations using the ImageJ plugin and Gaussian 

adaptive threshold to quantify observable cell abnormalities. This histological assessment will provide important insight 

into the phenotypic properties of the tissue microenvironment. This is in line with the development of pharmaceutical 

research which often relies on visual assessment of tissue morphology, either for characterization of in vivo experiments, 

pharmacodynamics, and mechanisms of action of drugs, as well as toxicological assessments or as criteria for clinical trials. 

Automatic computational analysis of histopathology data is expected to speed up tissue analysis work and provide more 

objective quantitation with rapidly developing technology, thereby increasing the effectiveness and performance of 

researchers. 

 

MATERIALS AND METHODS 

Materials 

The materials used in this study included a sciatic pain rat model, CO2 gas, 10% formalin, paraffin wax blocks, 95% ethanol, 

eosin, hematoxylin, xylene, and distilled water. The instrument and software used included a microscope, ImageJ, and 

Gaussian analysis program. 

 

 

https://imagej.net/ij/index.html


Borneo Journal of Pharmacy, Vol 7 Issue 2, May 2024, Pages 126 – 135  e-ISSN: 2621-4814 

128 

Methods 

The H&E staining and image digitization 

Diabetic peripheral neuropathy rats were euthanized by placing them in a closed container with a flow of CO2 gas. Sciatic 

nerve tissue was taken and fixed in 10% buffered formalin. After fixation, the tissue was dehydrated in gradient ethanol (70-

95%). The tissue was then cleaned using xylene. Tissue was embedded in paraffin wax blocks for sectioning and sectioned 

to a thickness of 5 μm using a microtome. Tissue samples were placed on microscope slides and deparaffinized using xylene 

(100%), then rehydrated with absolute ethanol, gradient ethanol, and finally distilled water. The slides were then washed 

using distilled water and soaked in hematoxylin for 3-8 minutes. The slides were then cleaned with running water for 20 

minutes and then rehydrated with ethanol 70-95%. The slides were then stained with eosin for 30 seconds, rinsed again with 

gradient ethanol immediately, and finally dried. Xylene was added to clear the tissue. The slide was then covered with a 

coverslip. The slides were analyzed microscopically and photographs were taken under a microscope at 4x and 10x 

magnification17. This study has been approved by the Animal Ethic Committee of Institut Teknologi Bandung with 

approved ID 08/KEPHP-ITB/3-2022. 

Manual analysis with ImageJ plugin 

Cell counting was performed using ImageJ software (https://imagej.net/ij/download.html) according to the instructions18. 

To count the cells, ImageJ was first installed. Then, the Cell Counter plugin was accessed by navigating to Plugins → Analyze 

→ Cell Counter. This plugin is compatible with single grayscale, single-color, or multicolor images. Grayscale images were 

identified by "8-bit" or "16-bit" at the top, while color images were labeled "RGB". Cells were counted by clicking on them in 

the image. Each click added a colored box around the cell and updated the count. If an object was mistakenly included, it 

could be removed using Edit → Undo (limited to one undo per action). After finishing the counting process, the total cell 

count was obtained by clicking Analyze → Measurements in the Results window. Results could be filtered, copied and 

pasted, or saved as an Excel .xls spreadsheet. Saving tagged images required using the Print Screen key and saving the 

capture as a .tif or .jpg file. 

Analysis with Gaussian adaptive threshold 

The first image (Image 0) was created to show the original image. The program first read the image named "Image.jpeg" 

and saved it in the variable 'im'. The image was then displayed. Next, the program converted the image in 'im' to grayscale 

and stored it in the variable 'Gray1'. The grayscale image was then smoothed using a Gaussian filter with a kernel of (5,5) 

and stored in the variable 'grey'. Variables were then configured for adaptive threshold processing: -maxValue = 255, -

adaptiveMethod = cv2. ADAPTIVE_THRESH_GAUSSIAN_C, -thresholdType = cv2.THRESH_BINARY, -blockSize = 3, - 

C = 2. The adaptive threshold process was carried out on the 'grey' image using the configured variables. The results of the 

process were stored in the variable 'im_threshold'. The connected objects in the image 'im_threshold' were calculated using 

the 'label' function in the SciPy library. The image labels were stored in the variable 'label_array'. The number of connected 

objects in the variable 'particle_count' was displayed in a comment line. 

 

Data analysis 

Analysis data was collected from three different areas of the image and then averaged to obtain the results. The resulting 

data was analyzed using paired T-test statistics, with a p-value of <0.05. 

 

RESULTS AND DISCUSSION 

Visualizing and annotating histopathology images is crucial for pharmaceutical research and clinical trials19. This study 

employed an automatic testing procedure with the Gaussian adaptive method to quantify histopathological features. The 

results showed no significant difference between the automatic method and manual calculations. Diabetic neuropathy 

involves oxidative damage that alters nerve structure. These changes, including axonal degeneration, segmental 

demyelination, and Schwann cell apoptosis, lead to damage or loss of myelin and unmyelinated fibers in patients. These 

histopathological changes manifest as distinct image features and colors between the normal and DPN groups, forming the 

https://journal.umpr.ac.id/index.php/bjop
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basis for the Gaussian method calculations. The study utilized a neuropathic diabetic pain model with nerve injury to induce 

hyperalgesia and allodynia in rodents, mimicking aspects of human neuropathic pain. 

In histopathological testing, the first step involves preparing tissue slides. To better visualize specific structures within the 

tissue, such as the nucleus and cytoplasm, staining is necessary. The (H&E) staining is the most common method used for 

histopathological examination of the sciatic nerve. Hematoxylin selectively binds to DNA, staining the nucleus blue or 

purple, while eosin stains other cellular components pink, allowing for clear differentiation of various structures20. 

Following histopathological staining, the slides are examined under a microscope and digitized using a camera. 

Representative areas were captured as digital images using a smartphone camera. The images were taken at a magnification 

of 40x objective lens and 10x eyepiece lens. Since magnification affects the level of detail visible, adjusting the image threshold 

might be necessary for optimal analysis.  Three images were chosen for cell analysis. Due to their large file size, captured 

RGB images are typically compressed using JPEG or JPEG 2000 formats21. 

Several factors can introduce challenges in creating optimal image designs for automated analysis of histopathology slides. 

These challenges arise from variations that can occur during tissue preparation, staining, and slide digitization22. Improper 

fixation, for example, can alter tissue morphology, leading to inaccurate results from image analysis software.  Differences 

in protocols and the appearance of staining reagents can vary considerably between laboratories. Even within a single lab, 

staining results may differ due to pre-analytical factors like fixation delays or incompatible staining conditions. Finally, 

variations in slide scanners' optics, photodetectors, and light sources can contribute to display inconsistencies. The 

histopathological findings in this study reveal a loss of regularity in the nerve fibers. This is attributed to nerve fiber 

degeneration, impaired myelin density, Schwann cell degeneration, and endometrial edema, as shown in Figure 1. 

 

 
Figure 1. Histopathology results of the sciatic nerve in diabetic rat neuropathology, the yellow arrow indicates damaged cells included in the calculation. 

 

ImageJ software, with its plugin feature, was used to analyze the digitized images. Plugins are functionalities available on 

all ImageJ versions, including the original (version 1), ImageJ2, and Fiji.  These plugins appear in the plugin menu (or a 

submenu) upon starting ImageJ. They enable various tasks beyond cell damage analysis, such as image rendering, user 

interface extensions, processing single-image microscopy data, and result analysis. This even includes finding and adjusting 

image points for reconstruction23. The results of image analysis using the ImageJ plugin can be seen in Figure 2. 
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Figure 2. Presentation of manual calculations using ImageJ, yellow dots indicate counted cells. 

 

For comparison purposes, the digitized images were also analyzed using the Gaussian adaptive thresholding method. This 

method divides the image into smaller regions, and calculates a specific threshold value for each region. This approach helps 

retain more information compared to simpler thresholding techniques. The threshold values are determined using a 

Gaussian function. Adaptive thresholding is particularly suitable for images with relatively uniform intensity levels24. 

The Gaussian adaptive thresholding method involves several steps. First, the color microscope image is converted to 

grayscale. Then, adaptive threshold segmentation is applied to identify background pixels. This technique classifies pixels 

based on their intensity: pixels brighter than a certain threshold are considered background, while darker pixels are 

considered foreground objects. The key factor in segmentation is the threshold value. In this method, the threshold for each 

pixel is calculated adaptively as the average intensity of its surrounding pixels within a 3 x 3 square region. Finally, binary 

segmentation creates a new image where each pixel is assigned a value of 0 (background) or 1 (object). Binarization 

essentially converts grayscale images into black and white (foreground and background).  Gaussian adaptive threshold is 

particularly useful for images with uneven lighting or variations in pixel intensity25. 

The Gaussian adaptive thresholding method uses an odd-sized block to analyze the image. This allows each block to have 

a unique threshold value that adapts to local variations in pixel intensity. A constant value (C) is then subtracted from the 

average intensity within each block to achieve the desired segmentation26. This technique is particularly effective at isolating 

individual nuclei, even those with faint or blurred boundaries, from the surrounding tissue27. The results of this image 

processing step are shown in Figure 3. 

 

https://journal.umpr.ac.id/index.php/bjop
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Figure 3. Presentation of calculation results with Gaussian adaptive threshold after normalization. Red arrows show examples of counted cells. In Gaussian 

the value is shown automatically. 

 

To obtain quantitative data, measurements were taken from three distinct regions of the sciatic nerve in a single slide. This 

approach ensures a comprehensive analysis of the sample. The measurements were then averaged to produce mean values, 

which are presented in a graph in Figure 4. This visual representation facilitates data interpretation and comparison. Figure 

4 shows that the average cell count obtained using ImageJ (213.00 ± 19.31 cells) is higher compared to the average obtained 

using Gaussian adaptive thresholding (204.67 ± 5.03 cells). This difference can be attributed to the underlying calculation 

principles. Manual analysis with ImageJ involves manually counting damaged nerve cells one by one. In contrast, Gaussian 

adaptive thresholding automates the process. By selecting an appropriate threshold, it converts the histopathology image 

into a binary image, preserving only essential information about the size and shape of the nuclear regions. This simplification 

reduces image complexity and facilitates feature extraction and classification28. Our findings align with previous study 

comparing manual and automated cell counting methods, which showed no significant differences in the average cell 

counts. The observed difference in standard deviation in this study might be due to a sample size of less than 100 slides, 

which is considered insufficient for statistically robust estimation of standard deviation29. 

 

 
Figure 4. Comparison of abnormal cell calculations with ImageJ and Gaussian. 
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This study explores the use of Gaussian adaptive thresholding for cell analysis in histopathology images. However, the 

method has limitations. Closely spaced cell nuclei might be misidentified as a single object, and inflammatory cells with 

similar color intensity may also be misinterpreted. Additionally, variations in background color intensity can affect results. 

Manual cell counting using software like ImageJ offers an alternative approach, but it suffers from limitations such as time 

consumption, high workload, and potential subjectivity. The digitization of biological data opens doors for computer-aided 

diagnosis30. While this study has not yet evaluated the accuracy of machine learning methods for this purpose, and the 

sample size remains relatively small, the precise calculation results obtained here suggest promise for developing a robust 

analytical method in the future. 

The ever-growing use of computers, coupled with the development of advanced image analysis algorithms, has fueled the 

development of computer-assisted approaches for analyzing biomedical data. Manual interpretation of tissue slides is a 

laborious, expensive process prone to human error and inconsistency. Automated image analysis offers a faster, more 

reproducible method for generating additional insights, aiding pathologists in reaching accurate diagnoses. However, 

challenges remain in computer-assisted diagnosis. One hurdle is achieving the necessary accuracy and speed to provide 

truly useful results, particularly when dealing with the large datasets generated by digital histology samples. Additionally, 

ensuring accessibility of these methods to the entire pathology community is another crucial hurdle to overcome31. 

 

CONCLUSION 

The calculation results of the two methods show no significant differences between the methods. The test results show that 

the computerized morphometric image analysis method has the potential to be applied in the digitalization of pathology 

because it can provide an image-based environment for managing and interpreting information generated from images on 

glass slides into quantitative data. This digitalization also offers substantial results in improving the safety of pharmaceutical 

drugs in toxicology testing, preclinical pathology, and clinical trials. 
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